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Introduction

This manual describes how to connect the Display and the External Device.

In this manual, the connection procedure will be described by following the sections below:

1 System Configuration

This section shows the types of External 

Devices which can be connected and SIO 

type.

"1 System Configuration" (page 3)

2 Selection of External Device

Select the model (series) of the External 

Device to be connected and its connection 

method.

"2 Selection of External Device" (page 10)

3 Example of Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Example of Communication Setting" (page 
11)

4 Setup Items

This section describes communication 

setup items on the Display.

Set the communication settings of the 

Display with GP-Pro EX or in offline mode.

"4 Setup Items" (page 62)

5 Cable Diagram

This section shows cables and adapters 

for connecting the Display and the 

External Device.

"5 Cable Diagram" (page 67)

Operation
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1 System Configuration

The following shows the system configuration where the External Device of KOYO ELECTRONICS INDUSTRIES 

CO., LTD. and the Display are connected.

Series CPU Link I/F SIO Type
Setting 

Example

Cable 

Diagram

KOSTAC 
SG

SG-8

CN1 on G-01DM
RS422/485

(4wire)

Setting 
Example 2 
(page 13)

Cable 
Diagram 2 
(page 69)

CN2 on G-01DM RS232C
Setting 
Example 1 
(page 11)

Cable 
Diagram 1 
(page 67)

General-purpose 
communication 
port on CPU*1

RS232C
Setting 
Example 3 
(page 15)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 4 
(page 17)

Cable 
Diagram 3 
(page 77)

KOSTAC 
SU

SU-5 U-01DM

RS232C
Setting 
Example 5 
(page 19)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 6 
(page 21)

Cable 
Diagram 2 
(page 69)

SU-5E
SU-6
SU-6B
SU-6B-C

U-01DM

RS232C
Setting 
Example 5 
(page 19)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 6 
(page 21)

Cable 
Diagram 2 
(page 69)

General-purpose 
communication 
port on CPU

RS232C
Setting 
Example 7 
(page 23)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 8 
(page 25)

Cable 
Diagram 3 
(page 77)
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KOSTAC 
SU

SU-5M
SU-5M-C

U-01DM

RS232C
Setting 
Example 5 
(page 19)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 6 
(page 21)

Cable 
Diagram 2 
(page 69)

General-purpose 
communication 
port 1 on CPU

RS232C
Setting 
Example 9 
(page 27)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 10 
(page 29)

Cable 
Diagram 3 
(page 77)

General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 11 
(page 31)

Cable 
Diagram 4 
(page 82)

SU-6M
SU-6M-C

U-01DM

RS232C
Setting 
Example 5 
(page 19)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 6 
(page 21)

Cable 
Diagram 2 
(page 69)

General-purpose 
communication 
port 1 on CPU

RS232C
Setting 
Example 9 
(page 27)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 10 
(page 29)

Cable 
Diagram 3 
(page 77)

General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 11 
(page 31)

Cable 
Diagram 4 
(page 82)

KOSTAC 
SZ

SZ-4
General-purpose 
communication 
port on CPU

RS232C
Setting 
Example 12 
(page 33)

Cable 
Diagram 4 
(page 82)

KOSTAC 
PZ3

PZ3-16ND1-16TD1
PZ3-T
PZ3M

General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 23 
(page 54)

Cable 
Diagram 6 
(page 86)

RS422/485
(4wire)

Setting 
Example 24 
(page 56)

Cable 
Diagram 7 
(page 88)

KOSTAC 
SR

SR-21
SR-22

E-02DM-R1
RS422/485

(4wire)

Setting 
Example 13 
(page 35)

Cable 
Diagram 2 
(page 69)

Series CPU Link I/F SIO Type
Setting 

Example

Cable 

Diagram
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DL-205

D2-240
General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 14 
(page 37)

Cable 
Diagram 4 
(page 82)

D2-250-1
General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 14 
(page 37)

Cable 
Diagram 6 
(page 86)

D2-260
General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 14 
(page 37)

Cable 
Diagram 6 
(page 86)

RS422/485
(4wire)

Setting 
Example 15 
(page 39)

Cable 
Diagram 7 
(page 88)

DL-405

D4--430 D4-DCM

RS232C
Setting 
Example 16 
(page 41)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 17 
(page 43)

Cable 
Diagram 2 
(page 69)

D4-440

D4-DCM

RS232C
Setting 
Example 16 
(page 41)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 17 
(page 43)

Cable 
Diagram 2 
(page 69)

General-purpose 
communication 
port on CPU

RS232C
Setting 
Example 18 
(page 45)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 19 
(page 47)

Cable 
Diagram 3 
(page 77)

D4-454*2

General-purpose 
communication 
port 1 on CPU

RS232C
Setting 
Example 25 
(page 58)

Cable 
Diagram 1 
(page 67)

RS422/485
(4wire)

Setting 
Example 26 
(page 60)

Cable 
Diagram 2 
(page 69)

General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 25 
(page 58)

Cable 
Diagram 8 
(page 93)

DL-305 D3-330 D3-DCM
RS422/485

(4wire)

Setting 
Example 20 
(page 49)

Cable 
Diagram 2 
(page 69)

Series CPU Link I/F SIO Type
Setting 

Example

Cable 

Diagram
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 Connection Configuration

• 1:1 Connection

• 1:n Connection

DirectLogic 
05

D0-05AA
D0-05AD
D0-05AR
D0-05DA
D0-05DD
D0-05DD-D
D0-05DR
D0-05DR-D

General-purpose 
communication 
port 1 on CPU

RS232C
Setting 
Example 22 
(page 53)

Cable 
Diagram 5 
(page 84)

General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 21 
(page 51)

Cable 
Diagram 5 
(page 84)

DirectLogic 
06

D0-06DD1
D0-06DD1-D
D0-06DD2
D0-06DD2-D
D0-06DR
D0-06DR-D
D0-06DA
D0-06AR
D0-06AA

General-purpose 
communication 
port 1 on CPU

RS232C
Setting 
Example 22 
(page 53)

Cable 
Diagram 5 
(page 84)

General-purpose 
communication 
port 2 on CPU

RS232C
Setting 
Example 21 
(page 51)

Cable 
Diagram 5 
(page 84)

*1 Remove the instruction word programmer from the programmer communication port during communication.

*2 Firmware version 8.05 or later is required. (For ADC in the United States, version 1.03 or later.)

• Set the execution time of the logic functions in the Display to "700 ms" or less. If the longer time is 

set, an error may occur in the communication with the external device.

Series CPU Link I/F SIO Type
Setting 

Example

Cable 

Diagram

Display
External Device

Display

External
Device

External
Device

External
Device

Maximum 16 units
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 IPC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B
COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD

COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model)

COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model)

COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3

*3 When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

COM1, COM2 - -

PL3000
COM1*1*2, COM2*1, 
COM3, COM4

COM1*1*2 COM1*1*2

PE-4000B Atom N270 COM1, COM2 - -

PE-4000B Atom N2600 COM1, COM2
COM3*4 , COM4*4, 
COM5*4, COM6*4

*4 Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

COM3*4, COM4*4, 
COM5*4, COM6*4

PS5000 (Slim Panel Type 
Core i3 Model) *5 *6 COM1, COM2*4 COM2*4 COM2*4

PS5000 (Slim Panel Type 
Atom Model) 
*5 *6

COM1, COM2*7 COM2*7 COM2*7

PS5000 (Enclosed Panel 
Type)*8 COM1 - -

PS5000 (Modular Type 
PFXPU/PFXPP)*5 *6

PS5000 (Modular Type 
PFXPL2B5-6)

COM1*7 COM1*7 COM1*7

PS5000 (Modular Type 
PFXPL2B1-4)

COM1, COM2*7 COM2*7 COM2*7

PS6000 COM1*9 *10 *10
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DIP Switch settings (PL3000 / PS3000 Series)

RS-232C

*5 When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.
When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6 To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

*7 Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8 For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PFXZPSCNM122.

*9 In addition to COM1, you can also use the RS-232C COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

Settings FAQ ID

PFXZPBMPR42P2, RS422/485 change method FA263858

PFXZPBMPR42P2 termination resistor setting FA263974

PFXZPBMPR44P2, RS422/485 change method FA264087

PFXZPBMPR44P2 termination resistor setting FA264088
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RS-422/485 (4 wire)

RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer
Select the manufacturer of the External Device to connect. Select "KOYO ELECTRONICS 
INDUSTRIES".

Series

Select the External Device model (series) and the connection method. Select "KOSTAC/DL 
Series CCM SIO".
In System configuration, make sure the External Device you are connecting is supported by 
"KOSTAC/DL Series CCM SIO".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Example of Communication Setting

The following shows examples of communication settings of the Display and the External Device, which are 

recommended by Digital Electronics Corp.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches or the short plug on the side of the link I/F unit. After 

completing the settings, reboot the External Device to enable them. Please refer to the manual of the External 

Device for details.

Configuration DIP Switch SW1

Configuration DIP Switch

Short plug (2)

DIP Switch Settings Setup Description

1 ON

Child station No.: 1

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 OFF

8 OFF Peer to Peer setting: 1:n mode

9 OFF Master/Slave setting: Slave

DIP Switch Settings Setup Description

1 ON

Baud rate transmission speed: 19,200bps2 ON

3 ON

4 ON Parity enable/disable: Enabled (odd)

5 OFF Self-diagnosis mode: OFF

6 OFF Turnaround delay: None

7 OFF
Response delay time: 0 ms

8 OFF

9 OFF Transmission mode: HEX mode

Short plug Setup Description

232C ENABLE SIO Type: RS232C
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches or the short plug on the side of the link I/F unit. After 

completing the settings, reboot the External Device to enable them. Please refer to the manual of the External 

Device for details.

Configuration DIP Switch SW1

Configuration DIP Switch

Short plug (2)

DIP Switch Settings Setup Description

1 ON

Child station No.: 1

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 OFF

8 OFF Peer to Peer setting: 1:n mode

9 OFF Master/Slave setting: Slave

DIP Switch Settings Setup Description

1 ON

Baud rate transmission speed: 19,200bps2 ON

3 ON

4 ON Parity enable/disable: Enabled (odd)

5 OFF Self-diagnosis mode: OFF

6 OFF Turnaround delay: None

7 OFF
Response delay time: 0 ms

8 OFF

9 OFF Transmission mode: HEX mode

Short plug Setup Description

232C DISABLE SIO Type: RS422
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the CPU unit. To set the station No., use the instruction 

word programmer (S-01P). After completing the settings, reboot the External Device to enable them. Please refer 

to the manual of the External Device for details.

Communication Setting Switch

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

DIP Switch Settings Setup Description

SW1 ON SIO Type: RS232C

SW2 OFF CCM station No. setting: Enabled

SW3 ON
Baud rate transmission speed: 19,200bps

SW4 ON

• Setting SW2 to ON switches the transmission mode to ASCII mode and thus disables 

communication. Make sure to set it to OFF and set the CCM station No. and transmission 

mode.

• Enter the station No. set on the Display.
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the CPU unit. To set the station No., use the instruction 

word programmer (S-01P). After completing the settings, reboot the External Device to enable them. Please refer 

to the manual of the External Device for details.

Communication Setting Switch

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

DIP Switch Settings Setup Description

SW1 OFF SIO Type: RS422

SW2 OFF CCM station No. setting: Enabled

SW3 ON
Baud rate transmission speed: 19,200bps

SW4 ON

• Setting SW2 to ON switches the transmission mode to ASCII mode and thus disables 

communication. Make sure to set it to OFF and set the CCM station No. and transmission 

mode.

• Enter the station No. set on the Display.
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3.5 Setting Example 5

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 20

 Settings of External Device

For communication settings, use the rotary switch on the front of the link I/F unit, or the DIP switches on its back. 

After completing the settings, reboot the External Device to enable them. Please refer to the manual of the 

External Device for details.

Station No. Setting Rotary Switch

Configuration DIP Switch SW4

Configuration DIP Switch SW5

Rotary Switch Settings Setup Description

x10 0 Station No. of the External Device (tens digit)

x1 1 Station No. of the External Device (ones digit)

• Enter the station No. set on the Display.

DIP Switch Settings Setup Description

1 ON

Baud rate transmission speed: 19,200bps2 ON

3 ON

4 ON Parity enable/disable: Enabled (odd)

5 OFF Self-diagnosis mode: OFF

6 OFF

Response delay time: 0 ms7 OFF

8 OFF

DIP Switch Settings Setup Description

1 OFF Peer to Peer setting: 1:n mode

2 OFF Master/Slave setting: Slave

3 OFF Timeout enable/disable setting: Normal operation mode

4 OFF Transmission mode: HEX mode
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3.6 Setting Example 6

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the rotary switch on the front of the link I/F unit, or the DIP switches on its back. 

After completing the settings, reboot the External Device to enable them. Please refer to the manual of the 

External Device for details.

Station No. Setting Rotary Switch

Configuration DIP Switch SW4

Configuration DIP Switch SW5

Rotary Switch Settings Setup Description

x10 0 Station No. of the External Device (tens digit)

x1 1 Station No. of the External Device (ones digit)

• Enter the station No. set on the Display.

DIP Switch Settings Setup Description

1 ON

Baud rate transmission speed: 19,200bps2 ON

3 ON

4 ON Parity enable/disable: Enabled (odd)

5 OFF Self-diagnosis mode: OFF

6 OFF

Response delay time: 0 ms7 OFF

8 OFF

DIP Switch Settings Setup Description

1 OFF Peer to Peer setting: 1:n mode

2 OFF Master/Slave setting: Slave

3 OFF Timeout enable/disable setting: Normal operation mode

4 OFF Transmission mode: HEX mode
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3.7 Setting Example 7

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the CPU unit. To set the station No., use the instruction 

word programmer (S-01P). After completing the settings, reboot the External Device to enable them. Please refer 

to the manual of the External Device for details.

Communication Setting Switch

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

DIP Switch Settings Setup Description

SW1 Optional Battery mode: Adjust to the system.

SW2 OFF CCM station No. setting: Enabled

SW3 ON
Baud rate transmission speed: 19,200bps

SW4 ON

• Setting SW2 to ON switches the transmission mode to ASCII mode and thus disables 

communication. Make sure to set it to OFF and set the CCM station No. and transmission 

mode.

• Enter the station No. set on the Display.
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3.8 Setting Example 8

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the CPU unit. To set the station No., use the instruction 

word programmer (S-01P). After completing the settings, reboot the External Device to enable them. Please refer 

to the manual of the External Device for details.

Communication Setting Switch

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

DIP Switch Settings Setup Description

SW1 Optional Battery mode: Adjust to the system.

SW2 OFF CCM station No. setting: Enabled

SW3 ON
Baud rate transmission speed: 19,200bps

SW4 ON

• Setting SW2 to ON switches the transmission mode to ASCII mode and thus disables 

communication. Make sure to set it to OFF and set the CCM station No. and transmission 

mode.

• Enter the station No. set on the Display.
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3.9 Setting Example 9

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the programmable controller. After completing the settings, reboot the External 

Device to enable them. Please refer to the manual of the External Device for details.

Configure the settings for general-purpose communication port 1 in the following special register.

1 On the External Device, set the mode switch to "TERM" and with the programmable controller connected to the 

programmer port, turn on the External Device.

2 Press the [Clear] key so that nothing is displayed in the message display area.

3 Press the [REG] key and enter "772". "R772" appears in the message display area.

4 Press the [R monitor] key. The current value of special register R772 appears in the message display area.

5 Press the [K(CON)] key, enter "0040" (CCM protocol) or "00E0" (auto-detect), and then press the [] key.

6 Repeat the operation to display the current value of special register R773.

7 Press the [K(CON)] key, enter "8601" and then press the [] key.

8 Repeat the operation to display the current value of the communication parameter in R767.

9 Press the [K(CON)] key, enter "AA5A" and then press the [] key. If the setting is completed successfully, the 

value changes to "AAAA".

Special Register Setup Items Setting Value Input Value

R772

Response delay time 0 ms
CCM: 0040
Auto-detect: 00E0

Communication timeout 0 ms

Communication protocol CCM or Auto-detect

R773

Parity Odd

8601
Stop bit 1

Communication speed 19,200 bps

Communication station number 1
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3.10 Setting Example 10

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the programmable controller. After completing the settings, reboot the External 

Device to enable them. Please refer to the manual of the External Device for details.

Configure the settings for general-purpose communication port 1 in the following special register.

1 On the External Device, set the mode switch to "TERM" and with the programmable controller connected to the 

programmer port, turn on the External Device.

2 Press the [Clear] key so that nothing is displayed in the message display area.

3 Press the [REG] key and enter "772". "R772" appears in the message display area.

4 Press the [R monitor] key. The current value of special register R772 appears in the message display area.

5 Press the [K(CON)] key, enter "0040" (CCM protocol) or "00E0" (auto-detect), and then press the [] key.

6 Repeat the operation to display the current value of special register R773.

7 Press the [K(CON)] key, enter "8601" and then press the [] key.

8 Repeat the operation to display the current value of the communication parameter in R767.

9 Press the [K(CON)] key, enter "AA5A" and then press the [] key. If the setting is completed successfully, the 

value changes to "AAAA".

Special Register Setup Items Setting Value Input Value

R772

Response delay time 0 ms
CCM: 0040
Auto-detect: 00E0

Communication timeout 0 ms

Communication protocol CCM or Auto-detect

R773

Parity Odd

8601
Stop bit 1

Communication speed 19,200 bps

Communication station number 1
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3.11 Setting Example 11

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the programmable controller. After completing the settings, reboot the External 

Device to enable them. Please refer to the manual of the External Device for details.

Configure the settings for general-purpose communication port 2 in the following special register.

1 On the External Device, set the mode switch to "TERM" and with the programmable controller connected to the 

programmer port, turn on the External Device.

2 Press the [Clear] key so that nothing is displayed in the message display area.

3 Press the [REG] key and enter "774". "R774" appears in the message display area.

4 Press the [R monitor] key. The current value of special register R774 appears in the message display area.

5 Press the [K(CON)] key, enter "0040" (CCM protocol) or "00E0" (auto-detect), and then press the [] key.

6 Repeat the operation to display the current value of special register R775.

7 Press the [K(CON)] key, enter "8601" and then press the [] key.

8 Repeat the operation to display the current value of the communication parameter in R767.

9 Press the [K(CON)] key, enter "A5AA" and then press the [] key. If the setting is completed successfully, the 

value changes to "AAAA".

Special Register Setup Items Setting Value Input Value

R774

Response delay time 0 ms
CCM: 0040
Auto-detect: 00E0

Communication timeout 0 ms

Communication protocol CCM or Auto-detect

R775

Parity Odd

8601
Stop bit 1

Communication speed 19,200 bps

Communication station number 1
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3.12 Setting Example 12

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the instruction word programmer (S-01P). After completing the settings, reboot 

the External Device to enable them. Please refer to the manual of the External Device for details.

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

5 Set the transmission speed to "19200", and then press the Enter key.

• Set the mode selector switch to TERM in the setup process.

• Enter the station No. set on the Display.
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3.13 Setting Example 13

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the side of the link I/F unit. After completing the settings, 

reboot the External Device to enable them. Please refer to the manual of the External Device for details.

Configuration DIP Switch SW1

Configuration DIP Switch SW2

DIP Switch Settings Setup Description

1 ON
Baud rate transmission speed: 19,200bps

2 ON

3 OFF Parity enable/disable: Disabled

4 ON Self-diagnosis mode: OFF

5 OFF Turnaround delay: None

6 OFF Power-on mode: Adjust to the system.

7 OFF Always OFF

8 OFF Transmission mode: HEX mode

DIP Switch Settings Setup Description

1 ON

Child station No.: 1

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 OFF

8 OFF Always OFF
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3.14 Setting Example 14

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the instruction word programmer (S-01P). After completing the settings, reboot 

the External Device to enable them. Please refer to the manual of the External Device for details.

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

5 Set the transmission speed to "19200", and then press the Enter key.

• Set the mode selector switch to TERM in the setup process.

• Enter the station No. set on the Display.
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3.15 Setting Example 15

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the instruction word programmer (S-01P). After completing the settings, reboot 

the External Device to enable them. Please refer to the manual of the External Device for details.

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

5 Set the transmission speed to "19200", and then press the Enter key.

• Set the mode selector switch to TERM in the setup process.

• Enter the station No. set on the Display.
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3.16 Setting Example 16

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the rotary switch on the front of the link I/F unit, or the DIP switches on its back. 

After completing the settings, reboot the External Device to enable them. Please refer to the manual of the 

External Device for details.

Station No. Setting Rotary Switch

Configuration DIP Switch SW4

Configuration DIP Switch SW5

Rotary Switch Settings Setup Description

x10 0 Station No. of the External Device (tens digit)

x1 1 Station No. of the External Device (ones digit)

• Enter the station No. set on the Display.

DIP Switch Settings Setup Description

1 ON

Baud rate transmission speed: 19,200bps2 ON

3 ON

4 ON Parity enable/disable: Enabled (odd)

5 OFF Self-diagnosis mode: OFF

6 OFF

Response delay time: 0 ms7 OFF

8 OFF

DIP Switch Settings Setup Description

1 OFF Peer to Peer setting: 1:n mode

2 OFF Master/Slave setting: Slave

3 OFF Timeout enable/disable setting: Normal operation mode

4 OFF Transmission mode: HEX mode
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3.17 Setting Example 17

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the rotary switch on the front of the link I/F unit, or the DIP switches on its back. 

After completing the settings, reboot the External Device to enable them. Please refer to the manual of the 

External Device for details.

Station No. Setting Rotary Switch

Configuration DIP Switch SW4

Configuration DIP Switch SW5

Rotary Switch Settings Setup Description

x10 0 Station No. of the External Device (tens digit)

x1 1 Station No. of the External Device (ones digit)

• Enter the station No. set on the Display.

DIP Switch Settings Setup Description

1 ON

Baud rate transmission speed: 19,200bps2 ON

3 ON

4 ON Parity enable/disable: Enabled (odd)

5 OFF Self-diagnosis mode: OFF

6 OFF

Response delay time: 0 ms7 OFF

8 OFF

DIP Switch Settings Setup Description

1 OFF Peer to Peer setting: 1:n mode

2 OFF Master/Slave setting: Slave

3 OFF Timeout enable/disable setting: Normal operation mode

4 OFF Transmission mode: HEX mode
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3.18 Setting Example 18

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the CPU unit. To set the station No., use the instruction 

word programmer (S-01P). After completing the settings, reboot the External Device to enable them. Please refer 

to the manual of the External Device for details.

Communication Setting Switch

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

DIP Switch Settings Setup Description

SW1 Optional Battery mode: Adjust to the system.

SW2 OFF CCM station No. setting: Enabled

SW3 ON
Baud rate transmission speed: 19,200bps

SW4 ON

• Setting SW2 to ON switches the transmission mode to ASCII mode and thus disables 

communication. Make sure to set it to OFF and set the CCM station No. and transmission 

mode.

• Enter the station No. set on the Display.
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3.19 Setting Example 19

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the CPU unit. To set the station No., use the instruction 

word programmer (S-01P). After completing the settings, reboot the External Device to enable them. Please refer 

to the manual of the External Device for details.

Communication Setting Switch

CCM Station No. Setting

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Enter the CCM station No. Press [0], [1], and then press the Enter key.

3 Set the transmission mode to "HEX", and then press the Enter key.

4 Set the parity to "ODD", and then press the Enter key.

DIP Switch Settings Setup Description

SW1 Optional Battery mode: Adjust to the system.

SW2 OFF CCM station No. setting: Enabled

SW3 ON
Baud rate transmission speed: 19,200bps

SW4 ON

• Setting SW2 to ON switches the transmission mode to ASCII mode and thus disables 

communication. Make sure to set it to OFF and set the CCM station No. and transmission 

mode.

• Enter the station No. set on the Display.
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3.20 Setting Example 20

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the DIP switches on the side of the link I/F unit. After completing the settings, 

reboot the External Device to enable them. Please refer to the manual of the External Device for details.

Configuration DIP Switch SW1

Configuration DIP Switch SW2

DIP Switch Settings Setup Description

1 ON
Baud rate transmission speed: 19,200bps

2 ON

3 OFF Parity enable/disable: Disabled

4 ON Self-diagnosis mode: OFF

5 OFF Turnaround delay: None

6 OFF Power-on mode: Adjust to the system.

7 OFF Always OFF

8 OFF Transmission mode: HEX mode

DIP Switch Settings Setup Description

1 ON

Child station No.: 1

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 OFF

8 OFF Always OFF
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3.21 Setting Example 21

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

For communication settings, use the instruction word programmer (Z-20JP). After completing the settings, reboot 

the External Device to enable them. Please refer to the manual of the External Device for details.

1 Select Menu 56. Press [Clear], [5], [6], [Menu], and then press the Enter key.

2 Set the protocol to "CCM2", and then press the Enter key.

3 Enter the CCM station No. Press [0], [1], and then press the Enter key.

4 Set the transmission mode to "HEX", and then press the Enter key.

5 Set the transmission speed to "19200", and then press the Enter key.

6 Set the stop bit to "1", and then press the Enter key.

7 Set the parity to "ODD", and then press the Enter key.

• Enter the station No. set on the Display.
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3.22 Setting Example 22

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

 Settings of External Device

The communication device does not require any communication settings.

The baud rate transmission speed and the station address are fixed.

The parity, data length, and stop bit also cannot be changed.
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3.23 Setting Example 23

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

Use the ladder software (DirectSOFT32 programming version 4.0) for communication settings. After completing 

the settings, reboot the External Device to enable them. Please refer to the manual of the External Device for 

details.

1 Start the ladder software (DirectSOFT32) and go online with the External Device.

2 From the [PLC] menu, select [Settings] - [General-purpose port settings].

3 In the [Communication port settings] dialog box, configure the following communication settings.

4 When the settings are complete, click [Transfer] to transfer them to the External Device.

Item Settings

Port Port 2

Protocol CCM Net (DirectNET)

Timeout 500 ms

RTS on Delay Time 20 ms

Station No. 1

Speed 19,200bps

Stop Bit 1

Parity Odd

Data Format Hex
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3.24 Setting Example 24

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

Use the ladder software (DirectSOFT32 programming version 4.0) for communication settings. After completing 

the settings, reboot the External Device to enable them. Please refer to the manual of the External Device for 

details.

1 Start the ladder software (DirectSOFT32) and go online with the External Device.

2 From the [PLC] menu, select [Settings] - [General-purpose port settings].

3 In the [Communication port settings] dialog box, configure the following communication settings.

4 When the settings are complete, click [Transfer] to transfer them to the External Device.

Item Settings

Port Port 2

Protocol CCM Net (DirectNET)

Timeout 500 ms

RTS on Delay Time 20 ms

Station No. 1

Speed 19,200bps

Stop Bit 1

Parity Odd

Data Format Hex
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3.25 Setting Example 25

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.
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 Settings of External Device

Use the KOYO PLC Programming Software for communication settings.

Please refer to the manual of the External Device for details.

1 Set the Keyswitch Mode of the External Device to "TERM".

2 Connect the PC to the general-purpose communication port of the External Device.

3 In the KOYO PLC Programming Software, select "New File" from the File menu.

4 Select the model of the External Device to use.

5 In the PLC View Window, select [PLC]  [PLC Setup]  [COM Port Setup].

6 Set the connection parameters between the PC and the External Device.

7 Click [Connection Test].

8 Select [PLC]  [PLC Setup]  [COM Port Setup].

9 Set the port parameters.

10 Click [Write PLC].
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3.26 Setting Example 26

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 61

 Settings of External Device

Use the KOYO PLC Programming Software for communication settings.

Please refer to the manual of the External Device for details.

1 Set the Keyswitch Mode of the External Device to "TERM".

2 Connect the PC to the general-purpose communication port of the External Device.

3 In the KOYO PLC Programming Software, select "New File" from the File menu.

4 Select the model of the External Device to use.

5 In the PLC View Window, select [PLC]  [PLC Setup]  [COM Port Setup].

6 Set the connection parameters between the PC and the External Device.

7 Click [Connection Test].

8 Select [PLC]  [PLC Setup]  [COM Port Setup].

9 Set the port parameters.

10 Click [Write PLC].
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4 Setup Items

Set the communication settings of the Display with GP-Pro Ex or in offline mode of the Display.

The setting of each parameter must be identical to that of the External Device.

"3 Example of Communication Setting" (page 11)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Setup Items Setup Description

SIO Type Select the SIO type for communicating with the External Device.

Speed Select the communication speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout
Use an integer from "1 to 127" to enter the time (s) for which the Display waits for the 
response from the External Device.

Continued to next page.
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 Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Retry
In case of no response from the External Device, use an integer from "0 to 255" to enter 
how many times the Display retransmits the command.

Wait To Send
Use an integer from "0 to 255" to enter the standby time (ms) from when the Display 
receives packets until it transmits the next command.

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for the SIO type.
To connect to the IPC, you need to use the IPC selector switch to change RI/5V. Please 
refer to the manual of the IPC for details.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"

Setup Items Setup Description

Series Select the series of the External Device.

Station No. Enter the station No. of the External Device, from "1 to 90".

Setup Items Setup Description
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4.2 Settings in Offline Mode

 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings] in offline mode. 

Touch the External Device you want to set from the list that appears.

• Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode 

or about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type for communicating with the External Device.

In the communication settings, confirm the serial interface specifications of the Display 
and set [SIO Type] correctly.
If you select an SIO type that the serial interface does not support, we cannot guarantee 
the operation.
Please refer to the manual of the Display for more details on the serial interface 
specifications.

Speed Select the communication speed between the External Device and the Display.

Data Length Select data length.

Continues to the next page.
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 Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the 

External Device you want to set from the list that appears, and touch [Device Settings].

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout
Use an integer from "1 to 127" to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from "0 to 255" to enter 
how many times the Display retransmits the command.

Wait To Send
Use an integer from "0 to 255" to enter the standby time (ms) from when the Display 
receives packets until it transmits the next command.

Setup Items Setup Description

Device/PLC Name
Select the External Device to set. Device name is the title of the External Device set with 
GP-Pro EX. (Initial value [PLC1])

Series Displays the series of the External Device.

Station No. Enter the station No. of the External Device, from "1 to 90".

Setup Items Setup Description
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 Option Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the 

External Device you want to set from the list that appears, and touch [Option].

Setup Items Setup Description

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for the SIO type.
To connect to the IPC, you need to use the IPC selector switch to change RI/5V. Please 
refer to the manual of the IPC for details.

• GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not 

have the [Option] setting in the offline mode.
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5 Cable Diagram

The following cable diagram may be different from the one recommended by KOYO ELECTRONICS 

INDUSTRIES CO., LTD. Please be assured, however, there is no operational problem in applying the cable 

diagram shown in this manual.

• The FG pin on the External Device must be D-class grounded. Please refer to the manual of the External 

Device for details.

• The SG and FG are connected inside the Display. If you connect the External Device to the SG, do not form 

any short-circuit loop in the system design.

• If the communication is not stable due to noise or other factors, connect an isolation unit.

Cable Diagram 1

1A)

Display

(Connection Port)
Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Available only with the COM ports that support RS-232C.
 IPC COM Port (page 7)

1A User-created cable
Cable length:
15m or less

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

1B User-created cable
Cable length:
15m or less

LT-4*01TM (COM1)
LT-Rear Module (COM1) 1C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

Cable length:
5m or less

Signal name

SD(TXD)3

SG5

7 RS(RTS)

ER(DTR)4

RD(RXD)2

CS(CTS)8

Display
D-Sub 9 pin (socket)

Pin Signal name

RTS4

RXD3

SG7
FG

CTS5

TXD2

D-Sub 25 pin (plug)
External Device

Pin
Shield

Display
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1B)

1C)

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

Signal name

SD(TXD)

SG
RS(RTS)

ER(DTR)

RD(RXD)

CS(CTS)

Signal name

RTS4

RXD3

SG7
FG

CTS5

TXD2

D-Sub 25 pin (plug)
External Device

Pin
Shield

Display

Display side 
Terminal block

Signal name 

RTS 4 

RXD 3 

SG 7 
FG 

CTS 5 

TXD 2 

D-Sub 25 pin (plug) 
External Device 

Pin Display

GND

TXD

RXD

(1)



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 69

Cable Diagram 2

Display

(Connection Port)
Cable Remarks

GP3000*1 (COM1)
AGP3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Available only with the COM ports that support RS-422/485 (4wire).  (Except PE-4000B, PS5000, and PS6000)
 IPC COM Port (page 7)

2A

COM port conversion adapter by Digital Electronics Corp.
CA3-ADPCOM-01

+
Connector terminal block conversion adapter by Digital 

Electronics Corp.
CA3-ADPTRM-01

+
User-created cable

Cable length:
600m or less

2B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

2C

Online adapter by Digital Electronics Corp.
CA4-ADPONL-01

+
Connector terminal block conversion adapter by Digital 

Electronics Corp.
CA3-ADPTRM-01

+
User-created cable

Cable length:
600m or less

2D

Online adapter by Digital Electronics Corp.
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1)

2E User-created cable
Cable length:
600m or less

GP4000*5 (COM2)
GP-4201T (COM1)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

2F

RS-422 terminal block conversion adapter by Digital 
Electronics Corp.

PFXZCBADTM1*8

+
User-created cable

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 2A.

Cable length:
600m or less

2B User-created cable

PE-4000B*9

PS5000*9

PS6000*9

*9 Available only with the COM ports that support RS-422/485 (4wire).
 IPC COM Port (page 7)

2G User-created cable
Cable length:
600m or less
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2A)

• 1:1 Connection

• 1:n Connection

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

Signal name

RDB

SDB
SG

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX
Signal name

+ RTS8
+ OUT14

- OUT15

0 V7

D-Sub 25 pin (plug)
External Device

Pin

- IN16

17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

- RTS11

12 + CTS

+ RTS10

- CTS13

- RTS9

150  (1/2W)

Terminal
resistance

Ω

User-created cable

RDB

SDB
SG

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

SDA

TERMRX
Signal name

+ RTS8
+ OUT14

- OUT15

0 V7

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

- RTS11

12 + CTS

+ RTS10

- CTS13

- RTS9

Shield

150Ω (1/2W)

Signal name

+ RTS8

0 V7

D-Sub 25 pin (plug)
External Device

Pin

- OUT23
- IN24

+ OUT22

+ IN25

FG

- RTS11

12 + CTS

+ RTS10

- CTS13

- RTS9
+ OUT14

- OUT15
- IN16

17 + IN

Signal name

Display

Display
Terminal block

Shield

D-Sub 25 pin (plug)
External Device

Terminal
resistance

User-created cable
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2B)

• 1:1 Connection

• 1:n Connection

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

Display

Shield

150 Ω  (1/2W)

Signal name

- RST11

12 + CTS

+ RTS

+ OUT

10

14

- OUT15

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

150 Ω  (1/2W)
Signal name

SDA3

RDB2

SG5

4 ERA

SDB

ERB

7

9

CSB6

RDA1

CSA8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin

+ RTS8
- RTS9

Shield

150 Ω  (1/2W)

Signal name

- RTS9

+ RTS8

0 V7

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- OUT23

- IN24

+ OUT22

+ IN25

FG

Display

Shield

 

Signal name

- RST11

12 + CTS

+ RTS

+ OUT

10

14

- OUT15

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

150 Ω  (1/2W)
Signal name

SDA3

RDB2

SG5

4 ERA

SDB

ERB

7

9

CSB6

RDA1

CSA8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin

+ RTS8
- RTS9

- IN16

17 + IN

+ OUT14

- OUT15

- RST11

12 + CTS

+ RTS10

- CTS13
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2C)

• 1:1 Connection

• 1:n Connection

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

Signal name

RDB

SDB
SG

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX

150 Ω  (1/2W)

Signal name

- RTS9

+ RTS8
+ OUT14

- OUT15

0 V7

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

- RST11

12 + CTS

+ RTS10

- CTS13

User-created cable

Shield Signal name

- RTS9

+ RTS8

- RST11

12 + CTS

+ RTS10

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

150 Ω  (1/2W)

Terminal
resistance

Pin

- OUT23

- IN24

+ OUT22

+ IN25

FG

Signal name

RDB

SDB
SG

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX

 

Signal name

- RTS9

+ RTS8
+ OUT14

- OUT15

0 V7

D-Sub 25 pin (plug)
External Device

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

- RST11

12 + CTS

+ RTS10

- CTS13

- IN16

17 + IN

+ OUT14

- OUT15

User-created cable
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2D)

• 1:1 Connection

• 1:n Connection

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

Signal name

RDB

SDB
SG

CA4-ADPONL-01

Display

Display
D-Sub 9 pin (plug)

Shield

RDA

SDA

TERMRX

150 Ω  (1/2W)

Signal name

+ RTS8
+ OUT14

- OUT15

0 V7

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

2

5

1

Pin

7
3
8

- RST11

12 + CTS

+ RTS10

- CTS13

- RTS9

User-created cable

Shield Signal name

+ RTS8
+ OUT14

- OUT15

0 V7

D-Sub 25 pin (plug)
External Device

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

Shield

150 Ω  (1/2W)

Signal name

- RTS9

+ RTS8

0 V7

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- IN16

- OUT23

- IN24

+ OUT22

+ IN25

FG

Signal name

RDB

SDB
SG

CA4-ADPONL-01

Display

Display
D-Sub 9 pin (plug)

RDA

SDA

TERMRX

2

5

1

Pin

7
3
8

- RST11

12 + CTS

+ RTS10

- CTS13

- RTS9

- OUT15
+ OUT14

17 + IN

- RST11

12 + CTS

+ RTS10

- CTS13

User-created cable
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2E)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Display

Shield

150 Ω  (1/2W)

Signal name

- RST11

12 + CTS

+ RTS

+ OUT

10

14

- OUT15

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

 
Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Terminal
resistance*1

+ RTS8
- RTS9

Display side 
Terminal block

Shield

150 Ω  (1/2W)

Signal name

- RTS9

+ RTS8

0 V7

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- OUT23

- IN24

+ OUT22

+ IN25

FG

Display

Shield

 

Signal name

- RST11

12 + CTS

+ RTS

+ OUT

10

14

- OUT15

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

 
Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Terminal
resistance*1

+ RTS8
- RTS9

- IN16

17 + IN

+ OUT14

- OUT15

- RST11

12 + CTS

+ RTS10

- CTS13

Display side 
Terminal block
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2F)

• 1:1 Connection

• 1:n Connection

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

Signal name

RDB

SDB
SG

PFXZCBADTM1

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX
Signal name

+ RTS8
+ OUT14

- OUT15

0 V7

D-Sub 25 pin (plug)
External Device

Pin

- IN16

17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

- RTS11

12 + CTS

+ RTS10

- CTS13

- RTS9

150  (1/2W)

Terminal
resistance

Ω

User-created cable

RDB

SDB
SG

PFXZCBADTM1

RDA

SDA

TERMRX
Signal name

+ RTS8
+ OUT14

- OUT15

0 V7

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

- RTS11

12 + CTS

+ RTS10

- CTS13

- RTS9

Shield

150Ω (1/2W)

Signal name

+ RTS8

0 V7

D-Sub 25 pin (plug)
External Device

Pin

- OUT23
- IN24

+ OUT22

+ IN25

FG

- RTS11

12 + CTS

+ RTS10

- CTS13

- RTS9
+ OUT14

- OUT15
- IN16

17 + IN

Signal name

Display

Display
Terminal block

Shield

D-Sub 25 pin (plug)
External Device

Terminal
resistance

User-created cable
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2G)

• 1:1 Connection

• 1:n Connection

• Connect a 150 termination resistor to the +IN and -IN that are not used.

• Connect a 150 termination resistor to the +IN and -IN that are not used.

Display

Shield

150 Ω  (1/2W)

Signal name

- RST11

12 + CTS

+ RTS

+ OUT

10

14

- OUT15

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

150 Ω  (1/2W)
Signal name

Tx+2

Rx-4

GND5

7 NC

Tx-

NC

1

9

NC6

Rx+3

NC8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin

+ RTS8
- RTS9

Shield

150 Ω  (1/2W)

Signal name

- RTS9

+ RTS8

0 V7

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

- OUT23

- IN24

+ OUT22

+ IN25

FG

Display

Shield

 

Signal name

- RST11

12 + CTS

+ RTS

+ OUT

10

14

- OUT15

0 V7

- CTS13

D-Sub 25 pin (plug)
External Device

Pin

- IN16
17 + IN

- OUT23

- IN24

+ OUT22

+ IN25

FG

150 Ω  (1/2W)
Signal name

Tx+2

Rx-4

GND5

7 NC

Tx-

NC

1

9

NC6

Rx+3

NC8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin

+ RTS8
- RTS9

- IN16

17 + IN

+ OUT14

- OUT15

- RST11

12 + CTS

+ RTS10

- CTS13
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Cable Diagram 3

Display

(Connection Port)
Cable Remarks

GP3000*1 (COM1) 
AGP3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Available only with the COM ports that support RS-422/485 (4wire).  (Except PE-4000B, PS5000, and PS6000)
 IPC COM Port (page 7)

3A

COM port conversion adapter by Digital Electronics Corp.
CA3-ADPCOM-01

+
Connector terminal block conversion adapter by Digital 

Electronics Corp.
CA3-ADPTRM-01

+
User-created cable

Cable length:
600m or less

3B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

3C

Online adapter by Digital Electronics Corp.
CA4-ADPONL-01

+
Connector terminal block conversion adapter by Digital 

Electronics Corp.
CA3-ADPTRM-01

+
User-created cable

Cable length:
600m or less

3D

Online adapter by Digital Electronics Corp.
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1)

3E User-created cable
Cable length:
600m or less

GP4000*5 (COM2)
GP-4201T (COM1)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

3F

RS-422 terminal block conversion adapter by Digital 
Electronics Corp.

PFXZCBADTM1*8

+
User-created cable

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.

Cable length:
600m or less

3B User-created cable

PE-4000B*9

PS5000*9

PS6000*9

*9 Available only with the COM ports that support RS-422/485 (4wire).
 IPC COM Port (page 7)

3G User-created cable
Cable length:
600m or less
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3A)

3B)

• Connect a 150 termination resistor to the +RXD and -RXD.

• Connect a 150 termination resistor to the +RXD and -RXD.

Signal name

RDB

SDB

SG

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

User-created cable

Shield

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

Display

150 Ω  (1/2W)
Signal name

SDA3

RDB2

SG5

4 ERA

SDB

ERB

7

9

CSB6

RDA1

CSA8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin
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3C)

3D)

• Connect a 150 termination resistor to the +RXD and -RXD.

• Connect a 150 termination resistor to the +RXD and -RXD.

Signal name

RDB

SDB

SG

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

User-created cable

Shield

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

Signal name

RDB

SDB

SG

CA4-ADPONL-01

Display

Display
D-Sub 9 pin (plug)

RDA

SDA

TERMRX

2

5

1

Pin

7
3
8

User-created cable
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3E)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

3F)

• Connect a 150 termination resistor to the +RXD and -RXD.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• Connect a 150 termination resistor to the +RXD and -RXD.

Shield

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

Display

 
Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Terminal
resistance*1

Display side 
Terminal block

Signal name

RDB

SDB

SG

PFXZCBADTM1

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

User-created cable
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3G)

• Connect a 150 termination resistor to the +RXD and -RXD.

Shield

150 Ω  (1/2W)

Signal name

- RXD10

+ RXD9

- CTS23

19 + RTS

+ CTS

+ TXD

11

14

- TXD16

SG7

- RTS18

D-Sub 25 pin (plug)
External Device

Terminal
resistance

Pin

FG

Display

150 Ω  (1/2W)
Signal name

Tx+2

Rx-4

GND5

7 NC

Tx-

NC

1

9

NC6

Rx+3

NC8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin
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Cable Diagram 4

4A)

Display

(Connection Port)
Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Available only with the COM ports that support RS-232C.
 IPC COM Port (page 7)

4A User-created cable
Cable length:
15m or less

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

4B User-created cable
Cable length:
15m or less

LT-4*01TM (COM1)
LT-Rear Module (COM1) 4C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

Cable length:
5m or less

Signal name

SD(TXD)3

SG5

7 RS(RTS)

ER(DTR)4

RD(RXD)2

CS(CTS)8

Display
D-Sub 9 pin (socket)

Pin Signal name

+ 5V2

RXD3

RTS5

6 0V

0V1

TXD4

External Device

PinShield

Display

Modular 6 pin
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4B)

4C)

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

Signal name

SD(TXD)

SG
RS(RTS)

ER(DTR)

RD(RXD)

CS(CTS)

Signal name

+ 5V2

RXD3

RTS5

6 0V

0V1

TXD4

External Device

PinShield

Display

Modular 6 pin
Display side 

Terminal block

Signal name 

+ 5V 2 

RXD 3 

RTS 5 

6 0V 

0V 1 

TXD 4 

External Device 

Pin 

Modular 6 pin 

Display

GND

TXD

RXD

(1)
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Cable Diagram 5

5A)

Display

(Connection Port)
Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Available only with the COM ports that support RS-232C.
 IPC COM Port (page 7)

5A User-created cable
Cable length:

3m or less

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

5B User-created cable
Cable length:

3m or less

LT-4*01TM (COM1)
LT-Rear Module (COM1) 5C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

Cable length:
5m or less

Signal name

SD(TXD)3

ER(DTR)4

7 RS(RTS)

SG5

RD(RXD)2

CS(CTS)8

Display
D-Sub 9 pin (socket)

Pin Signal name

SG1

RXD3

FG

TXD4

Modular 6 pin
External Device

PinShield

Display

Shell
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5B)

5C)

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

Signal name

SD(TXD)

ER(DTR)
RS(RTS)

SG

RD(RXD)

CS(CTS)

Signal name

SG1

RXD3

TXD4

Modular 6 pin
External Device

PinShield

Display

Display side 
Terminal block

Signal name

SG1

RXD3

TXD4

Modular 6 pin
External Device

PinDisplay

GND
TXD

RXD

(1)



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 86

Cable Diagram 6

6A)

Display

(Connection Port)
Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Available only with the COM ports that support RS-232C.
 IPC COM Port (page 7)

6A User-created cable
Cable length:
15m or less

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

6B User-created cable
Cable length:
15m or less

LT-4*01TM (COM1)
LT-Rear Module 
(COM1)

6C
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21
Cable length:

5m or less

Signal name

SD(TXD)3

SG5

7 RS(RTS)

ER(DTR)4

RD(RXD)2

CS(CTS)8

Display
D-Sub 9 pin (socket)

Pin Signal name

RTS4

RXD3

SG7

FG

CTS5

TXD2

High Density 15 pin (plug)
External Device

Pin
Shield

Display
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6B)

6C)

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

Signal name

SD(TXD)

SG
RS(RTS)

ER(DTR)

RD(RXD)

CS(CTS)

Signal name

RTS4

RXD3

SG7
FG

CTS5

TXD2

High Density 15 pin (plug)
External Device

Pin
Shield

Display

Display side 
Terminal block

Signal name

RTS4

RXD3

SG7
FG

CTS5

TXD2

High Density 15 pin (plug)
External Device

PinDisplay

GND

TXD

RXD

(1)
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Cable Diagram 7

Display

(Connection Port)
Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Available only with the COM ports that support RS-422/485 (4wire).  (Except PE-4000B, PS5000, and
PS6000)
 IPC COM Port (page 7)

7A

COM port conversion adapter by Digital Electronics Corp.
CA3-ADPCOM-01

+
Connector terminal block conversion adapter by Digital 

Electronics Corp.
CA3-ADPTRM-01

+
User-created cable

Cable length:
600m or less

7B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

7C

Online adapter by Digital Electronics Corp.
CA4-ADPONL-01

+
Connector terminal block conversion adapter by Digital 

Electronics Corp.
CA3-ADPTRM-01

+
User-created cable

Cable length:
600m or less

7D

Online adapter by Digital Electronics Corp.
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1)

7E User-created cable
Cable length:
600m or less

GP4000*5 (COM2)
GP-4201T (COM1)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

7F

RS-422 terminal block conversion adapter by Digital 
Electronics Corp.

PFXZCBADTM1*8

+
User-created cable

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 7A.

Cable length:
600m or less

7B User-created cable

PE-4000B*9

PS5000*9

PS6000*9

*9 Available only with the COM ports that support RS-422/485 (4wire).
 IPC COM Port (page 7)

7G User-created cable
Cable length:
600m or less
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7A)

7B)

• Connect a 150 termination resistor to the +RXD and -RXD.

• Connect a 150 termination resistor to the +RXD and -RXD.

Signal name

RDB

SDB
SG

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERM Signal name

+RXD13

-TXD10

SG7

14 +CTS

-RXD6

-CTS

+TXD9

+RTS11

High Density 15 pin (plug)
External Device

Pin

15

FG

-RTS12

150 Ω  (1/2W)

Terminal
resistance

User-created cable

Shield
Signal name

+RXD13

-TXD10

SG7

14 +CTS

-RXD6

-CTS

+TXD9

+RTS11

High Density 15 pin (plug)
External Device

Pin

15

FG

-RTS12

150 Ω  (1/2W)

Terminal
resistance

Display

150 Ω  (1/2W)
Signal name

SDA3

RDB2

SG5

4 ERA

SDB

ERB

7

9

CSB6

RDA1

CSA8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin
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7C)

7D)

• Connect a 150 termination resistor to the +RXD and -RXD.

• Connect a 150 termination resistor to the +RXD and -RXD.

Signal name

RDB

SDB
SG

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display
Terminal block

Shield

RDA

SDA

TERMRX Signal name

+RXD13

-TXD10

SG7

14 +CTS

-RXD6

-CTS

+TXD9

+RTS11

High Density 15 pin (plug)
External Device

Pin

15

FG

-RTS12

150 Ω  (1/2W)

Terminal
resistance

User-created cable

Signal name

RDB

SDB
SG

CA4-ADPONL-01

Display

Display
D-Sub 9 pin (plug)

Shield

RDA

SDA

TERMRX Signal name

+RXD13

-TXD10

SG7

14 +CTS

-RXD6

-CTS

+TXD9

+RTS11

High Density 15 pin (plug)
External Device

Pin

15

FG

-RTS12

150 Ω  (1/2W)

Terminal
resistance

Pin

7

8
5

2

3

1

User-created cable
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7E)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

• Connect a 150 termination resistor to the +RXD and -RXD.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Shield
Signal name

+RXD13

-TXD10

SG7

14 +CTS

-RXD6

-CTS

+TXD9

+RTS11

High Density 15 pin (plug)
External Device

Pin

15

FG

-RTS12

150 Ω  (1/2W)

Terminal
resistance

Display

 
Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Terminal
resistance*1

Display side 
Terminal block
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7F)

7G)

• Connect a 150 termination resistor to the +RXD and -RXD.

• Connect a 150 termination resistor to the +RXD and -RXD.

Signal name

SDB

SG
TERMRX

PFXZCBADTM1

Display

Display
Terminal block Shield Terminal block

External Device

RDB

SDB

Signal name
TXD+

TXD-

RXD+

RDA

RXD-

0V

TERM

180 Ω (1/2W)

Terminal
resistance

User-created cable

Shield
Signal name

+RXD13

-TXD10

SG7

14 +CTS

-RXD6

-CTS

+TXD9

+RTS11

High Density 15 pin (plug)
External Device

Pin

15

FG

-RTS12

150 Ω  (1/2W)

Terminal
resistance

Display

150 Ω  (1/2W)
Signal name

Tx+2

Rx-4

GND5

7 NC

Tx-

NC

1

9

NC6

Rx+3

NC8

Display
D-Sub 9 pin (socket)Terminal

resistance Pin
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Cable Diagram 8

8A)

Display

(Connection Port)
Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Available only with the COM ports that support RS-232C.
 IPC COM Port (page 7)

8A KOYO D2-DSCBL
Cable length:
15m or less

D-Sub 9Pin
(socket)

RJ12
connector

External Device
Display KOYO D2-DSCBL cable
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6 Supported Device

The following table shows the range of supported device addresses. Available type and range of device may vary 

depending on the CPU. Be sure to check them in each CPU manual before use.

6.1 KOSTAC SG Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I0000 - I1777 R40400 - R40477 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q0000 - Q1777 R40500 - R40577 *1

All Station 
Transmission Relay
(Input)

GI0000 - GI3777 R40000 - R40177 *1

Special Station 
Transmission Relay
(Output)

GQ0000 - GQ3777 R40200 - R40377 *1

Internal Relay M0000 - M3777 R40600 - R40777 *1

Special Relay SP000 - SP777 R41200 - R41237 *1

Timer (Contact) T000 - T377 R41100 - R41117 *1

Counter (Contact) C000 - C377 R41140 - R41157 *1

Stage S0000 - S1777 R41000 - R41077 *1

Timer (Elapsed Value) - R0000 - R0377

Counter (Elapsed 
Value)

- R1000 - R1377

Data Register 1 - R400 - R777

Data Register 2 - R1400 - R7377

Special Register - R7400 - R7777

Data Register 3 - R10000 - R37777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.2 KOSTAC SU Series

 SU-5/5E/6 Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I000 - I477 R40400 - R40423 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q000 - Q477 R40500 - R40523 *1

Link Relay/Link Input GI0000 - GI1777 R40000 - R40077 *1

Internal Relay M0000 - M0737 R40600 - R40635 *1

Special Relay
SP000 - SP137
SP320 - SP617

R41200 - R41205
R41215 - R41230

*1

Timer (Contact) T000 - T177 R41100 - R41107 *1

Counter (Contact) C000 - C177 R41140 - R41147 *1

Stage S0000 - S0577 R41000 - R41027 *1

Timer (Elapsed Value) - R0000 - R0177

Counter (Elapsed 
Value)

- R1000 - R1177

Data Register - R1400 - R7377

Special Register*2

*2 Data cannot be written.

- R7400 - R7777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 96

 SU-6B/6B-C Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I000 - I477 R40400 - R40423 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q000 - Q477 R40500 - R40523 *1

Link Relay/Link Input GI0000 - GI1777 R40000 - R40077 *1

Internal Relay M0000 - M1777 R40600 - R40677 *1

Special Relay
SP000 - SP137
SP320 - SP717

R41200 - R41205
R41215 - R41234

*1

Timer (Contact) T000 - T377 R41100 - R41117 *1

Counter (Contact) C000 - C177 R41140 - R41147 *1

Stage S0000 - S1777 R41000 - R41077 *1

Timer (Elapsed Value) - R0000 - R0377

Counter (Elapsed 
Value)

- R1000 - R1177

Data Register - R1400 - R7377

Special Register*2

*2 Data cannot be written. 

-
R700 - R737

R7400 - R7777

Extension Register - R10000 - R17777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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 SU-5M/5M-C/6M/6M-C Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I0000 - I1777 R40400 - R40477 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q0000 - Q1777 R40500 - R40577 *1

Link Relay/Link Input GI0000 - GI3777 R40000 - R40177 *1

Special Station 
Transmission Relay
(Output)

GQ0000 - GQ3777 R40200 - R40377 *1

Internal Relay M0000 - M3777 R40600 - R40777 *1

Special Relay SP000 - SP777 R41200 - R41237 *1

Timer (Contact) T000 - T377 R41100 - R41117 *1

Counter (Contact) C000 - C377 R41140 - R41157 *1

Stage S0000 - S1777 R41000 - R41077 *1

Timer (Elapsed Value) - R0000 - R0377

Counter (Elapsed 
Value)

- R1000 - R1377

Data Register - R1400 - R7377

Special Register*2

*2 Data cannot be written.

-
R700 - R777

R7400 - R7777

Extension Register - R10000 - R36777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.3 KOSTAC SZ Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I0000 - I0477 R40400 - R40423 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q0000 - Q0477 R40500 - R40523 *1

Internal Relay M0000 - M0377 R40600 - R40617 *1

Special Relay
SP000 - SP137
SP540 - SP617

R41200 - R41205
R41226 - R41230

*1

Timer (Contact) T000 - T177 R41100 - R41107 *1

Counter (Contact) C000 - C177 R41140 - R41147 *1

Stage S000 - S777 R41000 - R41037 *1

Timer (Elapsed Value) - R000 - R177

Counter (Elapsed 
Value)

- R1000 - R1177

Data Register - R2000 - R3777

Special Register - R7746 - R7777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.4 KOSTAC PZ3 Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I0000 - I0777 R40400 - R40437 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q0000 - Q0777 R40500 - R40537 *1

Internal Relay M0000 - M1777 R40600 - R40677 *1

Special Relay SP000 - SP777 R41200 - R41237 *1

Timer (Contact) T000 - T377 R41100 - R41117 *1

Counter (Contact) C000 - C177 R41140 - R41147 *1

Stage S0000 - S1777 R41000 - R41037 *1

Timer (Elapsed Value) - R00000 - R41177

Counter (Elapsed 
Value)

- R01000 - R41147

Data Register -
R1400 - R7377

R10000 - R17777

Special Register - R41200 - R41237

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.5 KOSTAC SR Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

I/O Relay
000 - 157
700 - 767

R000 - R014
R070 - R076 (first half 1 byte)

*1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Internal Relay
160 - 377
770 - 777

R016 - R036
R076 (latter half 1 byte)

*1

Shift Register 400 - 577 R040 - R056 *1

Timer/Counter 
(Contact)

600 - 677 R060 - R066 *1

Timer/Counter 
(Elapsed Value)

- R600 - R677

Data Register - R400 - R576

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.6 DL-205 Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay X0000 - X0477 V40400 - V40423 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Y0000 - Y0477 V40500 - V40523 *1

Control Relay C0000 - C0377 V40600 - V40617 *1

Special Relay
SP000 - SP137
SP320 - SP617

V41200 - V41205
V41215 - V41230

*1

Timer (Contact) T000 - T177 V41100 - V41107 *1

Counter (Contact) CT000 - CT177 V41140 - V41147 *1

Stage S000 - S777 V41000 - V41037 *1

Timer (Elapsed Value) - V0000 - V0177

Counter (Elapsed 
Value)

- V1000 - V1177

Data Register - V2000 - V3777

Special Register - V7746 - V7777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 102

6.7 DL-305 Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

I/O Relay
000 - 157
700 - 767

V000 - V014
V070 - V076 (first half 1 byte)

*1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Control Relay
160 - 377
770 - 777

V016 - V036
V076 (latter half 1 byte)

*1

Shift Register 400 - 577 V040 - V056 *1

Timer/Counter 
(Contact)

600 - 677 V060 - V066 *1

Timer/Counter 
(Elapsed Value)

- V600 - V677

Data Register - V400 - V576

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.8 DL-405 Series (D4-430, D4-440)

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay X000 - X477 V40400 - V40423 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Y000 - Y477 V40500 - V40523 *1

Link Relay GX0000 - GX1777 V40000 - V40077 *1

Link Output Relay GY0000 - GY3777 V40200 - V40377 *1

Control Relay C0000 - C1777 V40600 - V40677 *1

Special Relay
SP000 - SP137
SP320 - SP717

V41200 - V41205
V41215 - V41234

*1

Timer (Contact) T000 - T377 V41100 - V41117 *1

Counter (Contact) CT000 - CT177 V41140 - V41147 *1

Stage S0000 - S1777 V41000 - V41077 *1

Timer (Elapsed Value) - V0000 - V0377

Counter (Elapsed 
Value)

- V1000 - V1177

Data Register 1 - V400 - V777

Data Register 2 - V1400 - V7377

Special Register - V7400 - V7777

Data Register 3 - V10000 - V37777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.9 DL-405 Series (D4-454)

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay X0000 - X1777 V40400 - V40477 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Y0000 - Y1777 V40500 - V40577 *1

Remote Input GX0000 - GX3777 V40000 - V40177 *1

Remote Output GY0000 - GY3777 V40200 - V40377 *1

Control Relay C0000 - C3777 V40600 - V40777 *1

Special Relay SP000 - SP777 V41200 - V41237 *1

Timer T000 - T377 V41100 - V41117 *1

Counter CT000 - CT377 V41140 - V41157 *1

Stage S0000 - S1777 V41000 - V41077 *1

Timer (Current Value) - V0000 - V0377

Counter (Current Value) - V1000 - V1377

Data Register 1 V400.00 - V777.15 V400 - V777

Data Register 2 V1400.00 - V7377.15 V1400 - V7377

Special Register V7400.00 - V7777.15 V7400 - V7777

Data Register 3 V10000.00 - V37777.15 V10000 - V37777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.10 Direct Logic 05 Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I0000 - I0377 R40400 - R40417 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q0000 - Q0377 R40500 - R40517 *1

Internal Relay M0000 - M0777 R40600 - R40637 *1

Special Relay SP000 - SP777 R41200 - R41237 *1

Timer (Contact) T000 - T177 R41100 - R41107 *1

Counter (Contact) C000 - C177 R41140 - R41147 *1

Stage S000 - S377 R41000 - R41017 *1

Timer (Elapsed Value) - R000 - R177

Counter (Elapsed 
Value)

- R1000 - R1177

V-Memory - R1200 - R7377 *2

*2 No bits can be set for R1200 to R1377.

V-Memory  
Nonvolatile

- R7400 -R7577

System Parameter - R7600 - R7777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.11 Direct Logic 06 Series

 : This address can be specified as system data area.

Device Bit Address Word Address 32 bit Remarks

Input Relay I0000 - I0777 R40400 - R40437 *1

*1 When bits are written, the Display reads the corresponding word address from the External Device, sets
particular bits of that word address to ON, and then returns the resulting address to the External Device. Note
that the correct data may not be written if you change the word address using the ladder program while the
Display reads data from the External Device and returns it.

Output Relay Q0000 - Q0777 R40500 - R40537 *1

Internal Relay M0000 - M1777 R40600 - R40677 *1

Special Relay SP000 - SP777 R41200 - R41237 *1

Timer (Contact) T000 - T377 R41100 - R41117 *1

Counter (Contact) C000 - C177 R41140 - R41147 *1

Stage S0000 - S1777 R41000 - R41077 *1

Timer (Elapsed Value) - R000 - R377

Counter (Elapsed 
Value)

- R1000 - R1177

V-Memory -
R0400 - R0677
R1200 - R7377

R10000 - R17777

*2

*2 No bits can be set for R1200 to R1377.

V-Memory  
Nonvolatile

- R7400 -R7577

System Parameter -
R700 - R777

R7600 - R7777
R36000 - R37777

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type of the data 

display or other devices.

KOSTAC SG/KOSTAC SU/KOSTAC SZ/KOSTAC PZ3/Direct Logic 05/Direct Logic 06 Series

Device Device Name
Device Code

(HEX)
Address Code

Input Relay I/R 0080 Word Address

Output Relay Q/R 0081 Word Address

Link Relay GI/R 0082 Word Address

Link Output Relay GQ/R 0083 Word Address

Internal Relay M/R 0084 Word Address

Special Relay SP/R 0085 Word Address

Timer (Contact) T/R 00E0 Word Address

Counter (Contact) C/R 00E1 Word Address

Stage S/R 0004 Word Address

Timer (Elapsed Value) R 0060 Word Address

Counter (Elapsed Value) R 0061 Word Address

Data Register 1 R 0000 Word Address

Data Register 2 R 0001 Word Address

Special Register R 0002 Word Address

Data Register 3 R 0003 Word Address



KOSTAC/DL Series CCM SIO Driver

GP-Pro EX Device/PLC Connection Manual 108

KOSTAC SR Series

DL-205/DL-405 Series

Device Device Name
Device Code

(HEX)
Address Code

I/O Relay (R000 - R014)

.../R 0080
Value of word address 
divided by 2

I/O Relay (R070 - R076)

Internal Relay (R016 - R036)

Internal Relay (R076)

Shift Register

Timer/Counter (Contact)

Timer/Counter (Elapsed Value) R 0060 Word Address

Data Register R 0000
Value of word address 
divided by 2

Device Device Name
Device Code

(HEX)
Address Code

Input Relay X/V 0080 Word Address

Output Relay Y/V 0081 Word Address

Link Relay GX/V 0082 Word Address

Link Output Relay GY/V 0083 Word Address

Control Relay C/V 0084 Word Address

Special Relay SP/V 0085 Word Address

Timer (Contact) T/V 00E0 Word Address

Counter (Contact) CT/V 00E1 Word Address

Stage S/V 0004 Word Address

Timer (Elapsed Value) V 0060 Word Address

Counter (Elapsed Value) V 0061 Word Address

Data Register 1 V 0000 Word Address

Data Register 2 V 0001 Word Address

Special Register V 0002 Word Address

Data Register 3 V 0003 Word Address
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DL-305 Series

Device Device Name
Device Code

(HEX)
Address Code

I/O Relay (V000 - V014)

.../V 0080
Value of word address 
divided by 2

I/O Relay (V070 - V076)

Control Relay
(V016 - V036)

Control Relay (V076)

Shift Register

Timer/Counter (Contact)

Timer/Counter (Elapsed Value) V 0060 Word Address

Data Register V 0000
Value of word address 
divided by 2
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8 Error Messages

Error messages are displayed on the Display screen as follows: "No.: Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 1[01H])"

 Error Codes Specific to the External Device

Error codes specific to the External Device are shown below.

Item Description

No. Error No.

Device Name
Name of the External Device where an error has occurred. Device name is the title of the 
External Device set with GP-Pro EX. ((Initial value [PLC1])

Error Message Displays messages related to an error that has occurred.

Error Occurrence Area

Displays the IP address or device address of the External Device where an error has 
occurred, or error codes received from the External Device.

• IP address is displayed as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed as "Address: Device address".
• Received error codes are displayed as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.

• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the 

error messages common to the driver.

Error Code Description

01 A timeout has occurred on the serial link.

04 Unavailable I/O data has been requested.

0C During the header transfer, an error has occurred even after three retries.

0D During the data transfer, an error has occurred even after three retries.

14

During the data block transfer, one or more of the following errors have occurred:
 - Invalid STX has been received.
 - Invalid ETB has been received.
 - Invalid ETX has been received.
 - Invalid LRC has been received.
 - A parity error, framing error, or overrun error has occurred.

15 EOT reception from the parent station has resulted in failure.

16 ACK/NAK reception has resulted in failure during the wait state.
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1D

Except during the header/data transfer, one or more of the following errors have 
occurred:
 - Invalid STX has been received.
 - Invalid ETB has been received.
 - Invalid ETX has been received.
 - Invalid LRC has been received.
 - A parity error, framing error, or overrun error has occurred.

1E

During the header transfer, one or more of the following errors have occurred:
 - Invalid SOH has been received.
 - Invalid ETB has been received.
 - Invalid LRC has been received.
 - A parity error, framing error, or overrun error has occurred.

Error Code Description
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